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Conventions
The typographic conventions used in this help are described below.
Convention Description
Bold Used to denote components of the user interface such as

buttons, field names, menus, and menu options.
For example, the New button.

Menu...MenuOption Select the menu from the menu bar then select the menu option
from the menu.

For example, File...Open would mean to select the File menu
and then the Open option.

CAPS Used to denote the name of a key on the keyboard.
For example, the ENTER key.

Italics Used to denote emphasis, captions and the result of an action in
a procedure.

Contact Us
General enquiries on the HoloLive! for DigitalMicropraph should be sent to:

HREM Research Inc.
14-48 Matsukazedai
Higashimatsuyama
Saitama 355-0055

Japan
email: support@hremresearch.com
Website: www. hremresearch.com

Enquiries on HoloLive! of a technical nature should be directed to:

Dr. Christophe Gatel
CEMES-CNRS, Toulouse, France
email: christophe.gatel@cemes.fr
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Introduction to HoloLive!

Welcome to the HoloLive! plug-in for DigitalMicrograph (Gatan Inc.). This software is
designed to provide live phase images during off-axis electron holography experiments, hence
the exclamation mark. The software was developed because electron holograms are almost
impossible to interpret directly by the human eye: the important information is contained in the
phase, which requires reconstruction. We have found that being able to see the phase during
holography experiments changes the experience completely, particularly for in-situ work.

The main requirement is that the live holograms at the microscope are displayed within
DigitalMicrograph, in the usual viewing mode for Gatan cameras. As the hologram changes
over time, HoloLive! automatically recalculates and displays the corresponding phase image.
Using current computing power, a speed of 3 phase images per second can be obtained for a
4K by 4K digital hologram, with even higher speeds for smaller-sized holograms. Live features
include:

e Automatic detection and tracking of side band (via live FFT)
Carrier frequency refinement (via user-defined reference area)
Distortion correction (via a reference hologram)
Phase unwrapping
Fresnel fringe filtering
Amplitude and Cosine visualisation

HoloLive! has been briefly described in the following publication:

[1] C. Gatel, J. Dupuy, F. Houdellier, M.J. Hjtch, Appl. Phys. Lett. 113, 133102 (2018).
Unlimited acquisition time in electron holography by automated feedback control of
transmission electron microscope. 10.1063/1.5050906

Development versions of HoloLive! were used extensively in the following in-situ electron
holography work:

[2] C. Gatel, B. Warot-Fonrose, N. Bizi¢re, L. A. Rodriguez, D. Reyes, R. Cours, M.
Castiella, M.-J. Casanove, Nature Communications 8, 15703 (2017). Inhomogeneous

spatial distribution of the magnetic transition in an iron-rhodium thin film.
10.1038/ncomms15703

[3] C. Gatel, X. Fu, V. Serin, M. Eddrief, V. Etgens, B. Warot-Fonrose, Nano Letters 17,
2460—2466 (2017). In Depth Spatially Inhomogeneous Phase Transition in Epitaxial
MnAs Film on GaAs(001). 10.1021/acs.nanolett. 7600144

Without phase visualisation during experiments, how can you tell if the data being collected is
valuable? And during in-situ work, how could you tell if the applied stimuli are indeed changing
the fields? HoloLive! has been designed to help you during experiments, to make them more
productive and more interactive.

In this manual, we will dive straight into the use of the HoloLive! package with a prepared
example. Indeed, we have provided a stack of holograms, acquired experimentally, to simulate
work at the microscope. A simple script refreshes the hologram in a viewing window by cycling
through the data stack.



But before starting, there are a few important points to remember:

1.
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HoloLive! is a plug-in for DigitalMicrograph (Gatan Inc.). This means that results are
fully compatible with the other functions present in DM. For example, profiles drawn
across the live phase images using the DM line profile tool will be automatically
updated. Similarly, any calibration of the images within DM will be transferred to the
phase images.

2. The complete list of commands related to HoloLive! are located in the menu:

HoloLive Help

HoloLive! Control Window...

Play / Pause...

Stop

Define Reference Area
Live FFT Modulus
Zoom

Unwrap

Cosine

Settings 12

Power Spectrum
Shared Tools 12

Restore Factory Settings...

Help
About...

HoloLive Simulator ...

|

Apply...
Update

Define Reference Area...

Unwrap...

Cosine...

Live Contrast

Change Project Name
Define Image Type
Create ROI for Extract
Extract Area

Calcul of Lambda and

Area

CE

3. However, it is more fun to access command using the HoloLive! Control window

HololLive

Display
Binning P

ms O

Mask Size Type Fresnel

Il Apply [l Keep same q

wait [ s 29 | 0.000 s

M Freeze qvector [l Unwrap

o=

d A B @ mw

below. You have direct access to it via the Technique Manager.

Technical note: When the Technique
Manager is not displayed, you can
open it through Window -> Floating
windows -> Technique Manager.

Technical note: For GMS 2 .x, the
window can be opened from the first
item menu of the HoloLive menu:
HoloLive! Control Window...
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Note: Clicking on a button with CTRL key down will reveal the Settings (if present).
In the following, we will assume use of the HoloLive control window, but all commands
can be accessed via HoloLive menu.

Like a TV remote controller, check out the overall features below:

Reference
Area - FFT
Start/Pause \

J — Zoom

Stop —

{1 o I R )
L4 B © mw

A A A
Unwrap ~ Turbo
Phase - Boost
Display ‘ — Refresh

Cosine Contrast
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HoloLive! Tutorial
Getting Started

Open the image “Live Hologram” using the DM command File...Open from the HoloLive
Manual folder:

1 46 tive ologram Sakx

Technical note: this hologram was
acquired on the I2TEM microscope in
Toulouse (Hitachi HF 3300-C) using
a 4K OneView camera (Gatan Inc.)

It does not look like much for the moment but it is a real hologram. Use the DM magnifying

glass tool % to zoom in to see the narrow hologram fringes. Hint: if you are new to GMS 3,
remember you need to right-click on the image for the tools to appear.

HoloLive...Start/Pause (Button)

Now let’s use HoloLive! to calculate the phase image from this static hologram. Later on, we
will make this image move to simulate a microscope session. Select the “Live Hologram”
image by clicking on it somewhere (as usual in DM) and then just click on the Start/Pause
button in the HoloLive! control window:

HoloLive
Display
Binni ..
S b : Hint: if someone else has been
HA O playing the HoloLive! before you,
. check that the options in the control
Mask Size Type Fresnel window look like this and change

values if necessary. You can also use
Restore Factory Settings.

M Apply [ Keepsameq

wait (X s 9 | 0.000 s

M Freeze qvector [l Unwrap
ooll=
d A @ © mwr
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Since this is the first time HoloLive operates on this particular image, the Power Spectrum
of the hologram will be calculated, and the Phase Calculation dialog shown below will be
displayed. It should look something like this:

M-

Power Spectrum of Li

Hologram

- o x

Phase Calculation x

HEREE |ive Hologram

Mask

E3 Em-

Display
Binning M Phase O

Ol mie O

Reference JNEH QTS (31|

M Apply Correctio.. i

Cancel

Technical note: the power spectrum is the modulus squared of the Fourier transform of
the image. To avoid streaking from edge effects, the image was prefiltered. Any remaining
vertical streaking is due to the camera (in this case) or the finite width of the hologram.

Notice that the side band (at carrier frequency q) has been automatically detected and a red
circle has been placed around it with a radius indicative of the mask size. If for some
inexplicable reason (this is a worked example!) there is no circle or the circle is in the wrong
place, press Cancel. The Phase Calculation Window will disappear allowing you place a DM
Rectangular ROI tool {°% = around the side band. Press again on Start/Pause for HoloLive!
to find the side band position within the ROI. Just make sure the ROI encloses the side band
spot.

We will look at the other features later, but for now just click on OK, and you should see your
first phase image, called “Live Hologram P”:

N

Technical note: we like displaying phase
images using the “Temperature” colour scale
in DM but you can use grey scales if you
really want, just use the DM menu
Object...Image Display...Color. The actual
values in the phase image will not be
changed, only its appearance.

Technical note: in HoloLive!, every
image has a “type”, used in the titles and
in the image tags. For example, a phase
image is type P.
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Now, HoloLive! is running. However, the phase image is not changing, because the hologram
is static. We will see moving phase images and the use of this Start/Pause button later.

Hint: if you close the phase image, by

mistake or by intention, you may notice -
that the P box becomes unticked. F)ls-play _
HoloLive will continue working in the BT P
background. To make the phase image WA C
reappear, just click the P box.

HololLive

Mask Size Type Fresnel

M Apply [l Keepsameq

12400 [ set fRLIE

M Freeze qvector [l Unwrap
[> [ I R S O
d A B @ mwr

NOTE: The Start/Pause button can be distinguished by looking at the phase image. If the
phase image is continuously updated, the status is ON, so you stop updating by pressing the
Start/Pause button. Contrary, the image is not updated or you cannot find the phase image,
the state is OFF, and you can start phase calculation by pressing the Start/Pause button.

HoloLive...Reference Area (Button)

When analysing phase images, it is customary to define a reference area. Usually, a region of
vacuum is chosen where the hologram is undisturbed by any stray fields. In this example, the
whole hologram was taken in empty vacuum so you can choose anywhere using the DM
Rectangular ROI tool. Alternatively, you can just click on the Reference Area button to use
the default settings of HoloLive!:

HololLive
Display

Binning P O

A O Technical note: the default settings
is a reference area at the centre of the
image, rotated parallel to the
hologram fringes.
These settings can be modified in the
Reference Area dialog that will be
Remove Mean Val.. accessed via the Settings->Reference
Display Mean and Std. D... Area... menu or by pressing CTRL
while clicking on the Reference Area

o ] button,

B8 Mask Size Type Fresnel Reference Area
p%

Automatic Upda..

Automatic Rotati...

Il Apply M Keepsameq

wait (X s B¥ | 0.000 s

Il Freeze qvector [l Unwrap
ol s
[d B @ aw




HoloLive! Manual

HoloLive! will determine the average phase gradient in the reference area and subtract the
corresponding phase ramp from the whole image. This is equivalent to ensuring that the
carrier frequency q corresponds exactly to that of the chosen reference area of the hologram.
The result should look something like this:

Hint: if nothing happened, use
the Refresh button to make sure
HoloLive! updates the phase
image (this is a static hologram
after all).

HoloLive
Display
Binning P O

s O

[E8f Mask Size Type Fresnel

Keep same q

wait (XJls | 0.000s

W Freeze qvector [l Unwrap
Dol s
dBAE @ wr

The mean phase and standard deviation of the phase in the reference area are displayed on the
top left of the reference ROI. Feel free to move the ROI around and you will see the phase
image automatically updated (if not, check that the Automatic Update box is ticked in the
Reference Area dialog. Remember that Settings->Reference Area... menu or CTRL plus
clicking on the Reference Area button will display the settings.) You can also change the
size, shape and orientation of the ROI by grapping and dragging the different corners.

-10 -
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Live Holograms Processing

We could continue explaining the other features using a static hologram but it is more fun to
use a live one, just like at the microscope.

To simulate an on-line holography session off-line so to speak, we have created for you a
stack of 50 holograms acquired on the I2TEM microscope in Toulouse. Open the image stack
“HoloLive stack™. It is a stack of 4K by 4K holograms weighing a total of 3Gb so there might
be a pause. Scroll through the holograms if you like with the Slice tab of the DM Display
window (if absent use DM Window...Floating Window...Display). Now launch the menu
command HoloLive Simulator. Check that the “Live Hologram” image is still open (and
preferably the frontmost image). You should see the following dialog:

HoloLive! Control Window...

Play... View

D: Live Hologram 65536k .

Pause Stacked
Stop

B: HoloLive stack 3276800k ~

Define Reference Area
Live FFT Modulus

Zoon Hint: to stop the Simulator press on CRTL-SHIFT
Unwrap

Cosine »

Settings 4

Power Spectrum
Shared Tools 4

Restore Factory Settings...

Help
About...

HoloLive Simulator ... |

Choose as shown the “Live Hologram” to be the equivalent of the viewing screen (View) and
“HoloLive stack” to provide the images. On OK the script will replace the hologram in the
Live Hologram window with a hologram from the stack. The frequency is determined by the
number variable “wait” in the script (in seconds). Change it if you like. To halt the movie,
press down CTRL-SHIFT.

As if by magic, you should see the phase image changing as if it were live. The delay between

phase images is displayed on the HoloLive! control window:

HololLive HoloLive

Display Display
Binning P O o PO
mA O .
Hint: make sure you are
hE# Mask Size Type Fresnel on Binning 4 (01‘ hlgher)
E unless you want your

computer to have a
headache. See later for
more details.

Il Apply Keep same q

I Apply Keep same q

wait G s B 1 0.600 s

W Freeze qvector [l Unwrap

Dol =

d A B @ mr

-11 -

wait (Xl s B33 | 0600 s

W Freeze qvector [l Unwrap
o=
d A @ @ mw
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On the laptop used for writing this tutorial, the time is about 0.6s and varies depending what
else is going on the computer. To speed things up use the Turbo Boost:

W Freeze qvector [l Unwrap

o S |

PRER-BOE.

Technical note: In fact, MT stands for
“Multi-Threading”. Without Turbo
Boost, all operations (FFT, masks,
reference, etc.) will be done in the
sequence for each hologram.

Use the Start/Pause button to resume and suspend. Note that there is a delay between
stopping and starting. This is because it takes a certain time to create the first phase image in a
sequence which is longer than the delay between successive phase images using the Turbo

Boost.

Please be kind to HoloLive!
Your computer is having to do some pretty heavy calculations, especially
with a stack of 4K holograms. Everything has been done to optimise the
algorithms in order to reach these speeds but the computer is working flat
out. There will always be slight delays after clicking on a button. Please be
patient before clicking again.

To assuage your computer, you can always include a “Wait” time:

HololLive

Display
Binning P

o =

Mask Size Type Fresnel

W Apply Keep same q

) wait (S s B 023 s

M Freeze qvector [l Unwrap

Dol =

d A B @ =

Hint: after putting say 1 into the
Wait box, click the Set button for
the new value to take effect. You
should see the 1 become 1.0.

There are, however, better ways to help your computer by using Binning and ROIs, as we will

see later.

-12 -
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HoloLive... Live FFT (Button)

By default, the FFT of the hologram is shown live alongside the phase image. If it is not, click
on the FFT button in the HoloLive Control Window:

M Freeze qvector [l Unwrap

o S 1 |

d 3 B @ =

Technical note: it is too time consuming for HoloLive! to
calculate a live Power Spectrum (which includes masking in real-
space). The FFT button shows the modulus of the FFT of the
hologram (which had to be calculated anyway for the phase
image). You will therefore notice streaking of the spots. Purists
can see the static Power Spectrum using Power Spectrum menu.

Now place the Live FFT next to the phase image:

EE @ E e

If you press on the FFT button again, this closes the Live FFT window. Not to worry, you can
press on FFT button to make it reappear.

-13 -
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The FFT button does more than just displaying the FFT. It can be used to control the choice
of sideband. Place a DM Rectangular ROI around the other sideband as shown below:

8 x:Live Hologram MFFT o x

M P: Live Hologram P B
w— . .

Now press down SHIFT key and click on the FFT button. This tells HoloLive! to hunt for the
sideband within the ROI. You should see the red circle denoting the mask is swapped to the
new position:

X: Live Hologram MFFT I 1 X

gu«embgmp

Notice that the phase has changed sign, as it should do since q has changed to —q. This is such
a useful operation, that we have included a special Swap button on Mask Size tab of the
HoloLive Control Window to do this:

Technical note: the choice of sideband is

Display _ important for subsequent quantification. Our
Binning P () 9 . 2 o g
A = convention is that the sideband pointing towards
= the reference wave (usually the vacuum) should
Ref [IYERE Type Fresnel be chosen. In that case, the phase is positively
proportional to the mean-inner potential of the
| Medum, ~ | material. A positive phase gradient means
nm increasing sample thickness.

wait (XN s |

Have a go but remember the delay.

-14 -
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The main reason for including the ROI option on the FFT was for cases where HoloLive!
does not find the sideband. A classic example is when a hologram becomes too noisy (for
example, after jolting the microscope or biprism) and loses all contrast. The ROI guides
HoloLive! to the right place. Another way to avoid such mishaps is to use Freeze q vector:

HoloLive
Display
Binning P ()

o

G Mask Size Type Fresnel

Il Apply M Keepsameq

wait [ s 9 | 0284 s

( Freeze qvector YWl Unwrap

Duiglds

d B3 B @ @

By choosing this option, HoloLive! no longer hunts for the sideband in the live FFT, it just
continues to use the same carrier frequency q. There is a slight increase in speed. Unticking
the option just lets HoloLive! go back to automatically detecting the sideband.

A typical experimental procedure is to change the biprism voltage and the carrier frequency
changes. Untick the Freeze q vector and HoloLive! tracks the carrier frequency. Once the
biprism voltage is stable again, Freeze q vector can be reselected.

Another use of freezing q is to detect electric fields during in-situ biasing experiments. The q
vector can be frozen in the vacuum area, when a bias is applied, any gradient in the phase
image indicates the presence of an electric field. With automatic tracking, the phase gradient
would be automatically removed!

Mask Size Tab
Since we are on the Mask Size tab, let us look at the effect of changing the mask size for the
phase reconstruction.

HoloLive
Display Technical note: the default mask radii are the
Binning P O following: Small g/4, Medium q/3 and Large q/2.

WA O
. Technically, a mask size larger than Medium lets
Rl Mas<Size| e el information from the centre band leak into the

) 04192 | masked region. Holographers argue about whether
Large is acceptable or not.

3 B

wait [(XJls | o542

M Freeze qvector [l Unwrap
ool =
d 3 B © mw

-15-
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Use the scroll-down menu to choose a “Large” mask size. You should see the following
result:

Technical note: these
figures give the spatial
resolution of the phase
reconstruction. The
upper figure is in
pixels and the lower in
nm. If the original
hologram has not been
calibrated, the nm box
will be greyed out.

5|

EE@ G

The red circle has a larger radius on the live FFT and the phase image should look noisier but
finer grained. The standard deviation of the phase is indeed larger (see the information on the
Reference Area ROI). The spatial resolution of the phase map is now higher (see the
information on the HoloLive Control Window.) This is the price to pay for higher spatial
resolution: a lower signal-to-noise ratio for the phase.

You can choose any mask size by filling in the spatial resolution you want into the boxes
(either in 1/pixel or in nm), then the mask size name is shown as Custom. Choose 5 nm spatial
resolution for the phase reconstruction:

This is indeed a better way to define the mask size as it does not depend on the carrier
frequency, which might change during the experiment.

Now that we have seen the FFT, let us close the FFT window. Just close as usual in DM or
click on the FFT button. If you need it again, just click on the Live FFT button.

-16 -
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Ref (Reference Hologram) Tab

The large phase variations seen in this example are due to optical distortions of the
microscope, the projector lens distortions to be exact. To remove them, the conventional
procedure is to acquire a reference hologram in empty vacuum. Put HoloLive! on Pause state
using Start/Pause button and open the reference hologram that we have supplied “Holo
Reference”:

5§ AD: Holo Reference = Y

Technical note: this
reference hologram has some
pretty sensational contrast
because we used the drift
compensation, exposure time
of 4 mins and mt-shift
reconstruction (see Gatel et
al. APL 2018)

Hint: use the DM magnifying glass

tool Q to zoom in.

With the “Holo Reference” as the frontmost image, click on the Load icon on the Ref
(Reference Hologram) tab:

HoloLive HoloLive
Display Display
i = Technical note: as usual there Z =
- will be a pause as HoloLive!
O Mask Size  Type Fresnel calculates and stores the phase [E# Mask Size Type Fresnel
reconstructed from the Reference i
Holograrn. E" AD: Holo Reference

M Apply M Keepsameq

[l Apply M Keepsameq

When it is over, the title of the
wait G s B9 | 0569 s image will appear. It will be wait (NI s B9 | 0569 s
truncated to fit into the box.

W Freeze qvector [l Unwrap
ooldlls
[d B @ =

W Freeze q vector [l Unwrap
[> 1 m T S )
d 3 B @ =

HoloLive! uses exactly the same parameters (notably the mask size and binning) to
reconstruct the phase of the reference hologram. It stores the result ready for use.

-17 -
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Resume the live phase image by clicking on the Start/Pause button, and then click on the
Apply box to see the correction works:

W: Live Hologram P o x

HoloLive
Display
Binning P O

o e

Mask Size Type Fresnel

¥ an: Holo Reference

‘ Il Apply )W Keepsameq

wait CEI s B2y | 0569 s

W Freeze qvector [l Unwrap
> m T 0.}
B3 Ean

The phase variation across the field of view is much smaller. Click and unclick Apply to see
the improvement. Ideally, there should be no phase variation on correction (apart from the
noise from the counting statistics). As is often the case, the reference image was acquired a bit
later in the day when the imaging conditions had changed slightly.

Reference hologram... Keep same q

The reference phase was reconstructed using the same parameters as the live phase image, but
not necessary the same carrier frequency q. Indeed, HoloLive! hunts for the sideband
automatically and determines the peak position itself. This can be useful because the biprism
voltage can change slightly, or wilfully, between the current conditions and the reference
hologram conditions. Purists, who want exactly the same carrier frequency to be used for the
current hologram and reference hologram, can use the Keep same q option:

HoloLive
Display
Binning P )

o m

NGl Mask Size Type Fresnel

g AD: Holo Reference

Apply [ Keepsameq

wait (5l s B | 0317 s

M Freeze qvector [l Unwrap
ool =
dB 3 e

-18 -
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HoloLive...Unwrap Phase (Button)

As is well known, the phase is well defined in a range of 2w, and in our convention between -
n and 1. Holographers sometimes like to “unwrap” the phase. This means extending the phase
continuously beyond the 27 range. For example, if we are looking at a wedge-shaped sample,
we would like to see the phase from the mean-inner potential increase continuously from the
edge of the sample. We have therefore included an unwrapping capability.

To see the full effect, remove the Reference Hologram correction (untick Apply) so that the
phase has many phase jumps. Now click on Unwrap Phase button to see the transformation:

M8 w.Li [ - 0O x 8 w: Live Hologram P - o x

HoloLive

Display
Binning P O

WA O
hGl Mask Size Type Fresnel
Il Apply [l Keep sameq

wait G s B | 0859 s

[l Freeze q vector [ Unwrap
o=
d A @ @ =

Hint: Noisy images can cause phase
unwrapping to fail or give weird
results. Reduce the mask size to
compensate.

There is no unique solution to phase unwrapping in two dimensions and several methods have
been developed with their advantages and disadvantages!. The slower ones tend to be more
robust but for live phase visualisation speed is important. We have therefore developed two
algorithms (based on the Goldstein approach): one very fast and another one which is more
conventional. You can choose which one in the Settings->Phase Unwrapping...:

Phase Unwrapping Setup X

Algorithm
O Quick

@ Conventional

The tutorial holograms have a good signal-to-noise ratio, so the only difference you will see is
probably in the speed of execution. However, for noisier images the Conventional setting will
produce better results.

! See the excellent book by D.C. Ghiglia & M.D. Pritt, “Two-dimensional phase unwrapping: Theory, algorithms
and software” (John Wiley & Sons, Inc., New York, 1998).

-19-
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HoloLive...Zoom (Button)

Sometimes, you do not want to see the phase image corresponding to the whole field of view.
HoloLive allows you to see the phase in a smaller region.

First, put HoloLive on Pause using the Start/Pause button (this is not absolutely necessary
but is politer to the computer)

and then select the Live Hologram window by clicking on it. Then draw a region with the DM
Rectangular ROI tool:

Hint: if you hold down SHIFT
key, you force a square region,
and both ALT and SHIFT keys
forces sizes of powers of 2. Do
not worry though, HoloLive can
deal with any size or proportion.

If you have stopped phase updating, restart it by clicking on the Start/Pause button, and then
click on the Zoom button (Magnifying Glass):

Technical note: when the phase
is updating, you don’t need to
restart it again.

-20 -
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HoloLive will calculate and display the phase image corresponding to only this small region
of the hologram:

Technical note: the phase image is
calculated using your current settings
except Reference Area.

Notice that the ROI has become yellow, which indicates that it is active in HoloLive, and you
will see an updating phase image corresponding to the ROI area.

You can even move the ROI around (use the DM select/arrow tool to click inside the ROI,
then holding the left-click down, move the mouse) and the phase image is updated
automatically. You can maybe see this more clearly by not applying a reference hologram
correction and freezing the q vector.

The size and shape of the ROI can also be changed. However, be careful not to grab one of
the corners and change the shape too rapidly! When the size and/or shape of the ROI is
changed, HoloLive has to recalculate from scratch and performance suffers. Be kind to the
computer, shape changing is best done gently.

-21 -
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HoloLive! Manual

While we are in the Zoom mode, let us look at the Cosine button:

When clicking the Cosine button, a dialog to specify an amplification factor, o, will be open.

% DigitalMicrograph
Amplification factor ?

X

| 2.0

OK

Cancel

Technical note:

the amplification Factor determines the
cosine phase magnification. Displayed will be
the cosine of the phase times the factor.

By pressing OK, HoloLive! will display cos(a¢) in a new window, where ¢ is the phase. For
the default factor of two, the result will look something like:

Hint: to change the cosine factor
en route, click the Cosine button
with CTRL down to modify the

setting.

Holographers sometimes finds this useful to accentuate the phase variations. In fact, the
cosine function harks back to the original way of phase visualisation in the analogue days pre-

digital.

-02 -
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HoloLive...Contrast (Button)

Another useful feature linked to a selected area in the hologram image is the Live Contrast
function. Make sure that the Live Hologram is the frontmost image, and click on the Live
Contrast button:

Technical note: you do
not even have to have
phase images running
for this function to
work.

If an ROI was present, HoloLive! will use it, otherwise a default ROI will be created:

Hint: feel free to move
the ROI around or to
17.99% change its shape or size.

7.91 pix
0.74 ni

The information provided from top to bottom is the following: hologram fringe contrast,
fringe spacing in pixels, and the corresponding spacing in nm if the image has been calibrated.

The contrast uses the same definition as fringe visibility:
_ Inax = Imin
Imax + Imin
In the presence of noise, we should isolate the fringes from the background and measure their

average amplitude. However, for speed, we use an approximation based on the ratio of the
standard deviation of the intensity to the mean intensity:

_1o®
"=

For pure cosine fringes, the result would be correct. However, the method breaks down for a
noisy image with weak fringes. In the extreme case, in the absence of hologram fringes, we
would be measuring the noise level rather than the fringe contrast. Bare this in mind.
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HoloLive...Stop (Button)

All this time you may have been wondering what the Stop button does and the difference with
the Pause state. Give it a go:

HoloLive - -
Display Note: Stop menu or button will terminate
Binning P C phase calculation, and clean-up the
A O instances created for phase calculation.
Therefore, it is mandatory to use Stop
Mask Size Type Fresnel menu or button before you leave HoloLive.

W Apply Keep same q

wait (Xl s B39 1 0322 s

M Freeze qvector [l Unwrap
> J m S |
AE @ e

You may not have seen everything but it
is enough for now.
This is the end of the tutorial for
HoloLive!
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Quick Reference Guide

HoloLive Menu

HoloLive! Control Window...

Play / Pause...

Stop

Define Reference Area
Live FFT Modulus
Zoom

Unwrap

Cosine

Settings

Apply...
Update

Y

Define Reference Area...
Unwrap...

Cosine...

Power Spectrum
Shared Tools

Restore Factory Settings...

L\

Help
About...

HoloLive Simulator ...

Live Contrast

Change Project Name
Define Image Type

Create ROI for Extract Area
Extract Area

Calcul of Lambda and CE

The menu is not the only way to access the commands in HoloLive. The HoloLive
Control Window can be accessed through Technique Manager.

HoloLive Control Window

Stop

Start/Pause

Unwrap
Phase

||
m
[
|

Display
Cosine

Reference
Area - FFT

Zoom

UDB.
A B & mwv

A A A
~ Turbo
Boost
Refresh
Contrast

Commands can be activated by clicking on the buttons. In fact, this is the way we

usually use HoloLive.
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NOTE: When the Technique Manager is not displayed, you can open it through
Window -> Floating windows -> Technique Manager.

NOTE: In the case of GMS 2.x, the HoloLive Control Window can be opened from
the first menu of the HoloLive: HoloLive! Control Window...

HoloLive Main Menu

The commands in the HoloLive menu are described below.

Command

Description

Start/Pause
(Button)

When the front most image is a new hologram, this
menu or button will calculate Power Spectrum with an
automatically selected side-band within a red circle,
and then opens a dialog with the choice of options for
phase calculation (see below). When you click OK in
the dialog, Phase will be calculated for the hologram.

When the front most image is the Power Spectrum of a
hologram, Phase will be calculated for the parent
hologram.

The Start/Pause button resumes or suspend a live
phase update.

Stop
(Button)

This menu or button will terminate phase calculation,
and clean-up the instances created for phase
calculation. Therefore, it is mandatory to use Stop
menu or button before you leave the HoloLive.

Reference Area
(Button)

This menu or button will define an internal reference
area for the hologram fringes, when rectangular ROl is
present in the phase image. The corresponding carrier
frequency q is recalculated and the phase image
adjusted accordingly. If no ROl is present, a rectangular
ROl is created by default at the center of the phase
image.

Activating this command with CTRL key down will open
the Settings dialog with the choice of options (see
below).
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Live FFT
(Button)

This menu or button displays the FFT of a hologram. If
you select this menu or button again, the Live FFT
window will be closed. You can select this menu or
button to make it reappear.

When you use this menu or button with SHIFT key
down, a new side-band center will be searched within
the given ROl on the FFT.

Zoom
(Button)

This menu or button will display a magnified phase
image corresponding to the rectangular ROI on the
hologram.

When you move the ROI on the hologram or change
the size and shape of the ROI, the phase image will be
updated.

Unwrap Phase
(Button)

This menu or button will unwrap a phase image,
namely the phase value will be continuously extended
beyond the 2r range.

Activating this command with CTRL key down will open
the Settings dialog with the choice of options (see
below).

Display Cosine
(Button)

This menu or button will display cos(a¢) in a new
window, where ¢ is the phase. An amplification factor,
o, Will be specified in a popped-up dialog (see below).

Activating this command with CTRL key down will open
the Settings dialog with the choice of options (see
below).

Settings

Each submenu opens Settings dialog for corresponding
commands (see below).

Restore Factory
Settings

Resets all defaults and options to the initial values for
HoloLive.

HoloLive Simulator

Opens HoloLive simulator dialog.
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Phase Calculation Dialog

Phase Calculation X

MR ENE |ive Hologram

Mask

Vedun_~ | 1/picel
EX3 o

Digplay
Binning Phase O

_ W Amp

Reference UEHQT N

M Apply Correctio.. |}

The components of the dialog are described below.

Component

Description

Project Name

Name given to the group of images and results. By
default, this is the same as the front most hologram.

Mask

Size: Large (q/2), Medium (q/3), Small (q/4) and
Custom. Mask size in 1/pixel and real-space nm (if
calibrated).

Swap allows the opposite side-band to be chosen. The
g-vector should point towards the reference wave.

Binning

Selection of the binning factor from 1,2,3,4,5,6,7,8.

Display

Display controls for Phase and Amplitude (Amp).
Selections for Central-band or Side-band.

Reference Tab

For information about the components of the Display
tab, see Reference Tab below.

Mask Type Tab For information about the components of the Mask tab,
see Mask Type below.
Fresnel Tab For information about the components of the Display

tab, see Fresnel Tab below.
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Reference JEEH QT NS(3115]

M Apply Correctio.. i

Component

Description

Reference hologram

Scrolling menu to choose the reference hologram from
list of open images.

Apply Correction

Means that the hologram phase will be corrected using
the above chosen reference hologram image.

Keep same q

This means that the g-vector will be identical for the
object and reference holograms.

Mask Tvpe Tab Ref Mask Size Fresnel
@ Butterworth
O Cosine
@ Square
Component Description
Butterworth Butterworth shape for the mask.
Order Order of Butterworth filter.
Cosine Half-cosine mask with hard-cut off given by Mask Size.
Square Square mask with hard edges. Mask size defines the
half length of the square edge.
Fl’esnel Tab Reference  Mask Type
Medium =
M Apply Filter
Option Description

Fresnel Filter Strength

Strength of Fresnel filter: Weak, Medium, Strong.

Apply Filter

Defines whether Fresnel filter is applied or not.
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Cosine sub menu Apply..
Update

Command Description

Apply Creates an image that is equal to the cosine of the
frontmost phase image multiplied by a user-definable
Factor.

Update Ensures that the Cosine Image is updated using the
current Cosine Factor.

Settinqs sub menu Define Reference Area...
Unwrap...
Cosine...
Command Description

Define Reference Area

Opens a dialog to control Define Reference Area
command.

Unwrap

Opens a dialog for selecting an unwrapping scheme.

Cosine

Opens two dialogs to set Factor and Increment that
define an amplification factor.

Define Reference Area Dialog

Reference Area

Automatic Upda..
Automatic Rotati..
Remove Mean Val..

Digplay Mean and Std. D...

Option

Description

Automatic Update

Moving the reference area automatically updates the
phase images and reference values.

Automatic Rotation

fringes.

-30-

The ROl is rotated automatically parallel to the hologram




Remove Mean Value

HoloLive Manual

The average phase in the reference area is subtracted
from the whole phase image.

Display Mean and Std.
Dev.

The Mean and Standard Deviation of the phase in the
reference area is displayed above the ROI.

Unwrap Phase Dialog

Phase Unwrapping Setup

Algorithm
O Quick

@ Conventional

Cancel

Option Description
Quick Accelerated version of the Goldstein routine.
Conventional Conventional Goldstein routine for phase unwrapping.

Shared Tools sub menu Live Contrast
Change Project Name
Define Image Type
Create ROI for Extract Area
Extract Area
Calcul of Lambda and CE
Command Description

Live Contrast

Displays the fringe contrast, the fringe spacing (in
pixels and calibrated units) and mean intensity above a
rectangular ROI in the hologram image. A rectangular
ROI will be automatically created if absent. Values are
updated as the ROl is moved.

Change Project Name

Allows the project name to be changed.

Define Image Type

Allows the image type to be changed, changing the tag
of the image “Type”.

Create ROI for Extract
Area

Creates a rotatable ROI on front most image.
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Extract Area Creates a new image corresponding to rotatable ROI
on front most image.

Calculate of Lambda | Calculates and displays the value of the electron
and Ce wavelength and the hologram constant ce in the DM
Output window.
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